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About This Manual

The MicroTouch touchscreen is the most intuitive pointing device
available for the Apple Macintosh series of computers and monitors.
Touchscreens make using computers as simple as touching the screen.

TouchWare is compatible with all Macintosh applications, making it
ideal for a variety of situations, including point-of-sale, training
systems, information and self-service kiosks, factory automation and
process control, laboratory and medical instrumentation, interactive
selling demonstrations, and educational programs.

This manual describes how to

x Connect a touch monitor to a Macintosh

x Install the touchscreen software

x Customize your touchscreen for your working environment

x Configure multiple touchscreens in one system

This manual assumes the monitor has already been assembled with a
touchscreen and a controller.  If you need to retrofit your monitor with
a touchscreen and a controller, refer to the installation guide supplied
with your documentation package.



TouchWare for Macintosh User's Guide8

What You Need to Know

This document assumes you have basic computer skills.  You should
know how to use the mouse and keyboard, choose commands from
menus, open and run application programs, and save files.

If you need to learn more about these tasks, refer to the manuals and
diskettes that came with your Macintosh.

MicroTouch Support Services

MicroTouch provides extensive support services through our technical
support organization, web site, and bulletin board system (BBS).

MicroTouch Technical Support

Technical Support is available as follows:

x 24 hours a day, Monday through Friday (excluding holidays)

x 9:00 a.m. to 5:00 p.m. Eastern Standard Time, Saturday and
Sunday (excluding holidays)

Whenever you contact Technical Support, please provide the
following information:

x Part number and serial number from the MicroTouch label on your
monitor or touchscreen controller

x Type of MicroTouch touchscreen

x Version number of your MicroTouch TouchWare

x Make and model of your personal computer

x Name and version number of your operating system

x Type of mouse connected to your system

x List of other peripherals connected to your computer

x List of application software in use
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You can contact MicroTouch Technical Support by calling the hot line,
sending a fax, or sending electronic mail.

x Technical Support Hot Line: 978-659-9200

x Technical Support Fax: 978-659-9400

x Technical Support E-Mail: support@microtouch.com

MicroTouch on the World Wide Web

You can visit the MicroTouch web site at the following address:

http://www.microtouch.com

You can download MicroTouch touchscreen software and drivers,
obtain regularly updated technical information on MicroTouch
products, and learn more about our company.

MicroTouch Bulletin Board System

MicroTouch also has a Bulletin Board System (BBS) that you can
access 24 hours a day, 7 days a week.  You can use the BBS to
download updates of the latest drivers and obtain regularly updated
technical information on MicroTouch products.

You can reach the MicroTouch BBS at the following numbers:

x 978-659-9250

x 978-683-0358

To connect to the BBS, you need standard communication software
and a modem that supports 2400, 4800, 9600, 14400, or 28800 baud.
Additionally, the communication parameters must be set as follows:

No parity, 8 data bits, and 1 stop bit (N81)

Once you establish a modem connection with the BBS, the system
prompts you to log in using your name.  You can register with
MicroTouch the first time you log in to the BBS.  The menu of
available options is self-explanatory.

www.microtouch.com
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Installing the Touch Monitor

The MicroTouch TruePoint Macintosh monitor provides touch
technology in a simple plug-and-play package.  This chapter describes
how to set up your MicroTouch touch monitor with a Macintosh
system.

There are three basic steps to setting up your touch monitor:

1 Connect the touchscreen cable and the monitor video cable
to the Macintosh system unit.

2 Copy the touchscreen software from the installation diskette
to the hard disk.

3 Test that the installation was successful.

Once you set up the touch monitor, you can open and run any
Macintosh application.  To make a selection, you touch the screen.
It’s that simple and that natural – touch to select.
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Introduction to a Macintosh Touch System

With the release of TouchWare Version 3.3, Macintosh touch system
support has been expanded to include multiple monitors and multiple
touchscreens. The number of monitors you can have is limited only by
the hardware constraints of your system.  Up to two of these monitors
can have touchscreens installed.

The options in the TouchWare control panel are used to customize the
operation of the touchscreen.  The control panel has been designed to
work with any system configuration by separating these options into
Global Settings and Individual Settings.

Global settings are those options that are applied to all touchscreens in
a system simultaneously.

Individual settings are those options that are applied to a specific
(selected) touchscreen in a system.

There are three possible Macintosh system configurations:

x Single monitor with a touchscreen installed

x Multiple monitors with one touchscreen installed

x Multiple monitors with multiple touchscreens installed

Single Monitor with a Touchscreen Installed

For a system having a single touch monitor, there is no requirement to
select a touchscreen before specifying Individual Settings.  Both global
and individual settings are directed to the one touchscreen.

Multiple Monitors with One Touchscreen Installed

For a system having more than one monitor, but having only one
touchscreen installed, there again is no requirement to select a
touchscreen before specifying Individual Settings.  Both global and
individual settings are directed to the one touchscreen.
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However, because there are multiple monitors in the system, the
software needs to know which monitor has the touchscreen installed.
This is done by mapping.

When you open the control panel or Microcal with multiple monitors
installed, a Map Touchscreens option is available.  Mapping the
touchscreen allows you to identify to the software which monitor is
the touch monitor.

Multiple Monitors with Multiple Touchscreens Installed

For a system having multiple monitors, and more than one touchscreen
installed, you must select a touchscreen before specifying an individual
setting.

Before you can select a touchscreen, you must first map the
touchscreens in your system.  The software needs to know which
monitors are touch monitors.

When you open the control panel or Microcal with multiple touch
monitors installed, a Select Touchscreen option is available.
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System Requirements

The minimum system requirements for using the MicroTouch touch
monitor(s) and TouchWare for Macintosh are as follows:

Single Touch Monitor

x Apple Power PC or Power Macintosh

x Keyboard

x System 7.1.1 or newer operating system

x An available Apple Desktop Bus (ADB) port for connecting the
touchscreen

Multiple Touch Monitors

x Apple Power PC or Power Macintosh

x Keyboard

x System 7.1.1 or newer operating system

x Touchscreen controllers with an Output Identity of A50500 or
newer

x A video port for each monitor

x An ADB port for connecting each touchscreen

Note:   The maximum number of touch monitors (touchscreens)
supported in a system is two.
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Adapter for Goldstar and Mitsubishi Monitors

To connect a Goldstar or Mitsubishi monitor to a Macintosh, you
need an adapter for the video cable.  The adapter you need depends on
your monitor model as well as your Macintosh model.  You can
purchase the adapter from MicroTouch.  For more information,
contact a MicroTouch sales representative.

Unpacking the Touch Monitor

Carefully unpack the carton and inspect the contents for any damage.

Make sure you received the following items:

x Touch monitor with attached touchscreen controller and cable.
The controller may be mounted on the back of the monitor or
installed inside the monitor.

x TouchWare for Macintosh software diskette.

x Documentation.

x ADB-Splitter cable.  Using the ADB-Splitter cable is optional.
You need this cable only if you plan to connect two ADB devices
to the same ADB port.

MicroTouch provides one copy of the software and documentation,
and one ADB-Splitter cable with your initial system.  You order these
items separately for each additional system.

Save the invoice, shipping container, and all packing material in case
you need to transport the equipment any time in the future.
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Connecting a Touch Monitor

Connecting a touch monitor to your Macintosh is straightforward.
You need to connect three cables:

x The monitor video cable

x The touchscreen cable

x The monitor power cable

The monitor video cable is connected to a video port in the Macintosh
and the touchscreen cable is connected to an ADB port.

 

Touchscreen
controller

Touchscreen cable

Monitor video cable
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How to Connect a Touch Monitor

¾ To connect a touch monitor to your Macintosh:

1. Turn off your computer.  You should always turn off your
computer before connecting or disconnecting a device.

2. Connect the monitor video cable to the video port on the back of
your Macintosh.

Note:    Some monitors, such as a Goldstar or Mitsubishi monitor,
require an adapter on the video cable in order to connect the
monitor to the Macintosh.  The adapter you need depends on your
monitor model as well as your Macintosh model.  For more
information on buying an adapter, contact a MicroTouch sales
representative.

3. Connect the touchscreen cable to an available ADB port.

Every Macintosh has at least one Apple Desktop Bus (ADB) port
that you can use to connect an input device such as a touchscreen,
a keyboard, or a mouse.

 To connect the touchscreen to your Macintosh, you simply plug
the touchscreen cable into an available ADB port.  You have the
following options for connecting the touchscreen to your
Macintosh:

x You can connect the touchscreen directly to any free ADB port
in your system.

x You can connect the touchscreen to an ADB-Splitter cable.
This cable lets you connect two devices to one port.

 For example, to connect a touchscreen and a mouse to your
Macintosh but only have one ADB port available, you can use
the ADB-Splitter cable to connect both devices.

4. Connect the power cable to your monitor.  Plug the power cable
into a grounded power outlet.

5. Turn on your Macintosh.  You are now ready to install the
software for your touchscreen.
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How to Connect Multiple Touch Monitors

Each monitor, standard or touch, is connected to a separate video port
in the Macintosh.  To support multiple touch monitors, you may need
to install additional video cards.  Refer to your Macintosh
documentation for information on installing and configuring multiple
video cards.

All touch monitors are connected to the Macintosh in the same way.
Follow the procedure described previously in “How to Connect a
Touch Monitor” for each touch monitor.

Note:   When connecting multiple touch monitors in a system, each
touchscreen controller must have an Output Identity of A50500 or
newer.
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Checking Touchscreen Operation

After you have connected the touch monitor(s) to the Macintosh you
should complete the following test to determine if the touchscreen
hardware is working properly.

Checking a Touchscreen

¾ To check a touchscreen:

1. Turn on your Macintosh and monitor(s).

2. Adjust the contrast and brightness to suit your personal preference
and working environment.

3. Make sure the video image is centered within the screen area.  Use
the horizontal and vertical controls to adjust the video, if
necessary.

4. Look at the status light on the touchscreen controller.

x If the status light is on, the controller is receiving power and is
operating properly.

x If the status light is blinking, the controller’s internal self-test
failed.  There may be a problem with the controller hardware.
Contact MicroTouch Technical Support for more information.

5. Touch the screen while looking at the status light on the
touchscreen controller.

x If the status light brightens when you touch the screen, and
dims when you remove your touch, the touchscreen is
functioning properly.

x If the status light remains dim when you touch the screen, the
touchscreen is not functioning properly.  Contact MicroTouch
Technical Support for more information.

Checking Multiple Touchscreens

If you are using multiple touch monitors, repeat the check procedure
for each touchscreen.
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Installing the Touchscreen Software

To install the touchscreen software, you need the TouchWare for
Macintosh software diskette.

There are two options for installing the touchscreen software:

x If you are installing the touchscreen software onto your Macintosh
for the first time, refer to “First-Time Installation.”

x If you are upgrading the touchscreen software, you must remove
the existing touchscreen files.  Refer to “Upgrading from a
Previous Version.”

Files on the TouchWare Diskette

Table 1 lists the contents of the TouchWare for Macintosh diskette
and describes the purpose of each file.

Table 1.  TouchWare Files

Icon File Name Purpose

TouchWare Control panel and touchscreen driver.
Enables the touchscreen to work with
your Macintosh.

Microcal Diagnostic utility for testing and
adjusting touchscreen parameters.

Display Enabler Provides support for Display Manager
2.0. Copy this file into the Extensions
folder only if you are using System 7.5.2
or earlier.

TouchWare ReadMe Text file that contains the latest
documentation for the product.  Be sure
to check the information in the ReadMe
file before you install and use the
touchscreen software.
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The TouchWare touchscreen driver is a control panel device (CDEV)
that the Macintosh automatically loads when you start your system.
The touchscreen driver works with many popular third-party desk
accessories, initialization files, and other control panel devices that
may reside in the System Folder.

Viewing the ReadMe File

The TouchWare diskette includes a ReadMe file, which contains
product summary and enhancement information.

Before you install the touchscreen software, refer to the ReadMe file
for any last-minute changes and updates.

¾ To view and print the ReadMe file:

1. Insert the TouchWare for Macintosh diskette into the diskette
drive.

2. Double-click on the diskette icon to display the contents.

3. Double-click on the ReadMe file.  The system automatically uses
the Macintosh SimpleText application to open and display the
document.

x To view the document, use the scroll bar and arrow keys to
display the next and previous pages.

x To print the document, open the File menu and choose Print.

When you are done, open the File menu and choose Quit.  The system
closes the file, exits from the SimpleText application, and returns to
the Macintosh desktop.
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First-Time Installation

¾ To install the touchscreen software for a Macintosh:

1. Open the Control Panels folder.  The Control Panels folder is
located in the System Folder on your Macintosh startup drive.

2. Insert the TouchWare for Macintosh diskette into your diskette
drive.

3. Double-click on the diskette icon to display the contents of the
diskette.

4. Highlight the TouchWare file and then copy the file from the
diskette to the Control Panels folder on the Macintosh system
drive.

Note:   The TouchWare file must reside in the Control Panels folder.

5. Highlight the Microcal file and copy the file from the diskette to
your Macintosh system drive.  You can place the Microcal file
anywhere on your hard drive except in the Systems folder.

6. If you are using multiple monitors and your Macintosh is using
System 7.5.2 or earlier, then you must install the Display Enabler
extension.

 Highlight the Display Enabler extension and copy the file from the
diskette to the Extensions folder on your Macintosh system drive.

Note:   The Display Enabler extension must reside in the system
Extensions folder.

7. Open the Special menu and choose Restart.

 In order for the system to detect the touchscreen (or any new
Apple Desktop Bus device), you must restart the Macintosh.

 The Macintosh automatically ejects the TouchWare diskette.  Keep
the diskette in a secure place in case you need to reinstall any files.
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During the startup process, check that a TouchWare icon appears on
the screen along with other defined CDEVs and INITs.  The icon,
which indicates the touchscreen and driver are active, looks like this:

If the TouchWare icon has an X across it, the system did not detect
any touchscreens and did not load the touchscreen driver.

Check that the touchscreen cable is properly connected to an ADB
port and restart the Macintosh.  If the problem persists, refer to
Chapter 5 for troubleshooting tips.

Upgrading from a Previous Version

If you are upgrading the TouchWare software from a previous version,
you should back up the existing software and then delete it from the
hard disk before installing the new software.

Caution:   If you are upgrading from a previous version of the
Mac ’n Touch software, be sure to remove any old Mac ’n Touch
control panels from the System Folder.  In Version 3.0, the control
panel name changed from Mac ’n Touch to TouchWare.  Therefore,
the old control panel will not be overwritten when you install the new
TouchWare control panel.  Leaving the old Mac ’n Touch control
panel installed will cause problems and conflicts, including a system
crash when you open either control panel.
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¾ To upgrade to a newer version of the TouchWare software:

1. Back up your existing touchscreen software to a diskette.

2. Delete the old files from the hard disk.

 Do not leave any previous touchscreen control panels in the
System Folder because it will cause the touchscreen to operate
erratically.

3. Follow the procedures described in the “First-Time Installation”
section earlier in this chapter.

4. Be sure to restart your system after you install the new software.
In order for the system to detect the touchscreen (or any new
Apple Desktop Bus device), you must restart the Macintosh.
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Completing the Installation

To complete the installation you calibrate each touch monitor.  The
calibration process insures that the touchscreen is aligned properly
with the underlying video.  It also allows you to perform additional
tests to determine that the touchscreen is functioning properly and
accurately.

Systems with a Single Monitor

If your system is configured with a single monitor and touchscreen,
refer to “Calibrating the Touchscreen” in Chapter 2.  Follow the
calibration procedure described.  Test the calibration.

After you have completed calibration, proceed to Chapter 2 to
customize the operation of your touchscreen to suit your particular
application.

Systems with Multiple Monitors

If your system is configured with multiple monitors, you must
configure your Macintosh system before you can calibrate the
touchscreen(s).

Refer to Chapter 4 for information on:

x Configuring the Macintosh operating system

x Mapping the touchscreen(s)

x Using multiple touch monitors

After you have configured your system for multiple monitors and
mapped the touchscreen(s), refer to “Calibrating the Touchscreen” in
Chapter 2.  Follow the calibration procedure described.  Calibrate each
touchscreen in your system. Test each calibration.

After you have completed calibration, proceed to Chapter 2 to
customize the operation of your touchscreens to suit your particular
application.
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TouchWare Control Panel

The TouchWare control panel lets you customize the operation of
your touchscreen by selecting the way the cursor responds as you
touch the screen and as you move your finger.

You can use the TouchWare control panel to

x Select and change the touch mode

x Change the tap speed and tap area

x Calibrate the touchscreen

x Adjust the cursor vertical offset

x View the monitor IDs

x Map the touchscreens

x Perform a soft reset
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Control Panel Basics

The TouchWare control panel allows you to customize how your
touchscreen responds.  You can specify the touch mode, tap speed and
area, and cursor vertical offset.  In addition, you can calibrate your
touchscreen or issue a soft reset.

Opening the Control Panel

¾ To access the TouchWare control panel, use one of the following
methods:

x Open the Apple menu ().  Choose Control Panels and select
TouchWare.

x Open the System Folder and then open the Control Panels folder.
Double-click on the TouchWare file.

The Map Touchscreens
option is enabled only
when multiple monitors
are installed.

The Select Touchscreen
option is enabled only when
multiple touchscreens are
connected.

A global setting is
applied to all
touchscreens
simultaneously.

An individual setting
is applied to the
current touchscreen
only.
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Global Versus Individual Settings

Note that the control panel has two types of settings:

x Global Touchscreen Settings

x Individual Touchscreen Settings

A global setting is applied to all touchscreens in a system
simultaneously.  An individual setting is applied to the currently
selected touchscreen only.

The difference between a global and an individual setting is important
only if you have more than one touch monitor connected to your
system.

If your system has only one touch monitor, all settings are applied to
that touchscreen.

Options for Multiple Monitors

The Show Monitor ID option, the Map Touchscreens option, and the
Select Touchscreen option help you to configure your system for
multiple monitors.  TouchWare dims the option if it is not valid for
your configuration.

For more information on using multiple monitors, refer to Chapter 4.
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Selecting a Touch Mode

Touch mode defines exactly how your touch will be interpreted by
your computer.  Use the Touch Mode option to specify the touch
actions that equate to mouse events like clicking, double-clicking, and
dragging.

The Touch Mode option is a global setting.  Whether you have one or
several touch monitors installed in your system, the touch mode you
select is applied to all touchscreens simultaneously.

There are three touch modes available:

In describing these touch modes, the following terminology is used:

x Touch means to place your finger on the screen

x Tap means to touch the screen and quickly lift your finger off the
screen

Liftoff Mode

In liftoff mode, the initial touch locates the cursor on the screen.  You
can slide your finger around on the screen to reposition the cursor if
desired.  When you lift your finger off the screen, a single click occurs
at that location.  Lifting your finger is equivalent to pressing and
releasing the mouse button.  Liftoff mode is the default touch mode.

To double-click, quickly tap the object twice, in the same location.

To drag an object, tap to select the object and then quickly touch the
object again.  The second touch is equivalent to pressing and holding
down the mouse button.  You can now slide your finger to drag the
object to a new location.  When you are satisfied with the new
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location, lift your finger off the screen.  Lifting your finger is
equivalent to releasing the mouse button.

For a double-click or drag to occur, the second touch must take place
within the tap speed and area settings defined in the TouchWare
control panel.  If the second touch is outside these limits, the
touchscreen interprets it as a new touch.  Refer to the description of
tap speed and tap area later in this chapter.

Tap Mode

In tap mode, the initial touch only locates the cursor on the screen.
You can lift your finger off the screen and then touch the screen again
to reposition the cursor if desired.  Lifting your finger off the screen
does not produce a click.

To click, tap the object twice, in the same location.

To double-click, tap the object three times, in the same location.

To drag an object, tap to select the object and then quickly touch the
object again.  Dragging in tap mode is identical to dragging in liftoff
mode.  The second touch is equivalent to pressing and holding down
the mouse button.  You can now slide your finger to drag the object to
a new location.  When you are satisfied with the new location, lift your
finger off the screen.  Lifting your finger is equivalent to releasing the
mouse button.

Note that the taps must take place within the tap speed and area
settings defined in the TouchWare control panel.  If a subsequent tap
is outside these limits, the touchscreen interprets the tap as a new
touch.  Refer to the description of tap speed and tap area later in this
chapter.
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Drag Mode

In drag mode, the initial touch is equivalent to pressing and holding
down the mouse button.  You can drag your finger to move an object,
size windows, scroll through menus, or highlight text.  When you are
done dragging, lift your finger off the screen.  Lifting your finger is
equivalent to releasing the mouse button.

When using drag mode, be sure to precisely place your finger when
you touch the screen because some programs activate a selection on
the touch, rather than on lift off.

To click, touch the object and then lift your finger off the screen.

To double-click, quickly tap the object twice, in the same location.
Double-click in drag mode is identical to double-click in liftoff mode.
Also, for the double-click to occur, the second touch must take place
within the tap speed and area settings defined in the TouchWare
control panel.

To drag an object, touch the object and then drag the object to a new
location.  Remember in drag mode the initial touch is equivalent to
pressing and holding down the mouse button.
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Summary of Touch Modes

Table 2 summarizes the events associated with each touch mode.

Table 2.  Comparison of Touch Modes

Event Liftoff Mode Tap Mode Drag Mode

When the
action occurs

A touch positions
the cursor.  Lifting
your finger is
equivalent to
pressing and
releasing the
mouse button.

A touch positions
the cursor.  No
action occurs
when you lift your
finger off the
screen.

A touch is
equivalent to
pressing and
holding down the
mouse button.
Lifting your finger
is equivalent to
releasing the
mouse button.

Click x Touch the screen.

x Slide your finger
to position the
cursor, if
necessary.

x Lift your finger
off the screen.

x Tap the object
twice, in the same
location.

x Touch the object.

x Lift your finger
off the screen.

Double-click x Tap the object
twice quickly at
the same location.

x Tap the object
three times, in the
same location.

x Same as liftoff
mode.

Drag x Tap the object
and then quickly
touch it again.

x Drag the object to
a new location.

x Lift your finger
off the screen.

x Same as liftoff
mode.

x Touch the object.

x Drag the object to
a new location.

x Lift your finger
off the screen.
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Setting the Tap Speed and Tap Area

The tap speed and tap area define the conditions that must exist for the
system to interpret your touches as a double-click or drag.

Tap speed and area are global settings.  They are applied to all
touchscreens in your system simultaneously.

The tap speed defines how quickly you must touch the screen for the
system to register a double-click or drag.  In other words, speed
defines how much time can elapse between touches.

x Slow speed – allows for more sedate movements because the time
allowed between touches is long

x Medium speed – suitable for most applications

x Fast speed – provides for rapid touch and tap recognition

The tap area defines the maximum area in which successive touches
will be recognized as occurring at the same touch point.  In other
words, area defines how close one touch must be to the next touch for
the system to register a double-click or drag.

x Large Area – the area for subsequent touches is big

x Medium Area – suitable for most applications

x Small Area – the area for subsequent touches is small and precise

If your next touch occurs within the defined tap speed and area, then a
double-click or drag occurs.  If the next touch is not within the defined
speed and area, then the system interprets the touch as a new first
touch.
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If the tap speed is fast, and you tap slowly, the application interprets
two successive taps as two single clicks, rather than as a double-click.
Alternatively, if the tap area is small, and your taps are a large distance
apart, the application interprets two successive taps as two single
clicks, rather than as a double-click.  The best setting depends on
your application.
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Calibrating the Touchscreen

Calibration is the process of aligning the touchscreen with the
underlying video.  Calibration defines the dimensions of the image area
of the screen, determines the edge of the screen image, and locates the
center of the touchscreen.  You should always calibrate at the screen
resolution you will be using.

When You Should Calibrate

You should calibrate the touchscreen in the following cases:

x After you have initially installed your touch system

x Any time you change your video card, swap in a new monitor, or
add another touch monitor

x Any time the cursor does not accurately follow the movement of
your finger

x Any time you cannot position the cursor at the edges or corners of
the screen image

x Any time you change the size or position of the video image area
by adjusting the controls on your monitor

x Any time you adjust the touchscreen operating frequency

x Any time you issue a Restore Factory Defaults command

How to Touch the Screen During a Calibration

Calibration requires you to touch targets that are displayed on the
screen.  To obtain the most accurate calibration results:

x Touch each target with the fingertip of an extended finger.

x Keep your palm and free hand away from the touchscreen and
monitor.

x Touch as close to the center of the target as possible.



Chapter 2  TouchWare Control Panel 37

x Remember that the liftoff position – not the touchdown position –
determines the calibration point when you calibrate the
touchscreen.  Therefore, if your touch position is not quite
centered on the target, you can slide your finger to the center of
target, hold steady momentarily, and then lift your finger off the
screen.

x Hold your finger as still as possible after you reach the final
calibration location.  Always lift your finger straight off the
touchscreen.  Do not use any swiping motion during liftoff.

Calibration Procedure

The calibration procedure is quick and easy, and insures that the
touchscreen is aligned with the underlying video image.  Data from
this procedure is stored within the touchscreen controller in non-
volatile memory.  This means that you do not need to calibrate your
touchscreen each time you turn on your system.

If you have multiple touchscreens installed, refer to Chapter 4,
“Multiple Touch Monitors,” for information on selecting a
touchscreen.  Calibration is an individual option which requires that a
touchscreen be selected.

¾ To calibrate the touchscreen:

1. Make sure the monitor has been powered on for at least five
minutes.  This allows the monitor to reach its normal operating
temperature and stabilize before you attempt to calibrate the
touchscreen.

2. Open the TouchWare control panel.

3. Select Calibrate.  A calibration target appears in the lower left
corner of the screen.

 



TouchWare for Macintosh User's Guide38

4. Touch the center of the target.  Make sure to follow the guidelines
described previously in “How to Touch the Screen During a
Calibration.”  Hold your touch for at least three seconds.

 When you lift your finger, a second calibration target appears in
the upper right corner of the screen.

5. Touch the center of the target. Make sure to follow the guidelines
described previously in “How to Touch the Screen During a
Calibration.”  Hold your touch for at least three seconds.

 When you lift your finger, TouchWare saves the new calibration
values and returns to the control panel.

Note:   The calibration routine will automatically exit if no touch is
detected within 25 seconds.  In this case, the current calibration
values are not changed.

Testing the Calibration

¾ To test the accuracy of your calibration:

1. Touch the center of the screen and check that the cursor is located
underneath your finger.

2. Drag your finger across the screen and check that the cursor
follows your movements.

3. Move your finger to each corner and edge of the screen.  Check
that the cursor follows your finger and reaches the edges of the
screen image.

If any part of the calibration test fails, calibrate the touchscreen again.
Make sure to touch the targets carefully.  It is possible that one of
your touches did not register properly, or you accidentally touched the
screen in the wrong place during calibration.  For example, if you
touch beyond the targets or into the black non-image area, you will
distort the touchscreen calibration.

If you are still experiencing problems with the cursor positioning or
touch accuracy, refer to “Testing the Touchscreen” in Chapter 3.
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Calibration Resets the Vertical Offset

The calibration routine resets any previously applied cursor vertical
offset to zero.  After a calibration is done, you need to set the vertical
offset again.

Setting a Cursor Offset

After you calibrate the touchscreen, the cursor should be located
directly underneath your finger when you touch the center of the
screen.  However, you may prefer to offset the cursor slightly above
your finger so that you can point more easily and precisely.

The Vertical Offset option lets you define the amount of space
between your finger touch and the position of the cursor on the screen.
Offsetting the cursor is helpful when selecting small items, such as
single letters in word processing, check boxes, or radio buttons.

The Vertical Offset option is a global setting.  Whether you have one
or several touch monitors installed in your system, the offset you set is
applied to all touchscreens simultaneously.

¾ To offset the cursor:

1. Open the TouchWare control panel.

2. Select Vertical Offset.  The following screen appears:

 The tip of this arrow represents
the position where the cursor will
appear relative to your finger.
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3. Touch the screen below the tip of the arrow.  You can drag your
finger into position.  TouchWare does not calculate the offset
amount until you lift your finger off the screen.  The vertical
distance between your finger’s liftoff point and the tip of the arrow
is the offset amount.  Thereafter, the screen cursor will be
positioned above your finger by the offset amount.

Note:   You can automatically set the cursor offset to zero by
selecting the Reset option.

The following conditions apply to the cursor offset:

x When you calibrate the touchscreen, TouchWare automatically
resets the cursor offset to zero.

x As your finger approaches the bottom edge of the screen, the
cursor offset decreases automatically so that you can touch items
in this area.

Using Monitor IDs

The Macintosh operating system creates an identification number for
each monitor connected to it.  You use these monitor IDs when
mapping and selecting touchscreens.

Displaying All Monitor IDs

Use the Show Monitor IDs option to display the Monitor IDs on the
screen of each monitor in your system.  When you select the Show
Monitor IDs option, TouchWare displays an ID number on each
monitor screen for two seconds.  The Show Monitor IDs option is
especially useful if your system has multiple monitors installed.
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Viewing the Monitor ID of Current Touchscreen

Located at the bottom of the TouchWare control panel is the Monitor
ID of Current Touchscreen status.  This status identifies the currently
selected touchscreen for systems configured with multiple
touchscreens.  Individual settings, such as Calibrate and Reset, only
apply to the current touchscreen.

Mapping the Touchscreens

When you have multiple monitors installed, TouchWare needs to know
which monitors have a touchscreen installed.  You use the Map
Touchscreens option to assign each touchscreen to its associated
monitor.  For more information, refer to Chapter 4.

If you do not have multiple monitors installed, the Map Touchscreens
option is not enabled.  There is no need to map your touchscreen if
you have only one monitor.

Performing a Soft Reset

When you select the Reset option, the system

x Recalculates the touchscreen operating conditions (for example,
stray and offset capacitance values).

x Resets the cursor vertical offset to zero.  You will need to set the
vertical offset again.

The Reset option does not alter the hardware operation.  Instead, the
Rest option updates the controller’s information about the touchscreen
operating conditions.

It is useful to issue a soft reset if you are troubleshooting a problem
with your touchscreen or if you want to automatically set the vertical
cursor offset to zero.
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Getting Information About TouchWare

To obtain information about TouchWare, use the Get Info command.
This information includes such items as version number, file size, and
modification date.

¾ To view information about TouchWare:

1. Highlight the TouchWare file name or icon in the Control Panels
folder.

2. Open the File menu and choose Get Info.  The TouchWare Info
window appears.

 

 

 



C H A P T E R  3

Microcal Diagnostic Utility

The Microcal utility lets you test and adjust the performance of the
touchscreen.  The set of Microcal options is for diagnostic purposes
only.  You do not need to run Microcal unless you are experiencing
problems with your touchscreen.

You can use Microcal to

x Verify that the touchscreen is properly connected

x View the status information of the current touchscreen

x Test the performance of the touchscreen using the Draw program

x Calibrate the touchscreen

x Adjust the touchscreen operating frequency

x Linearize the touchscreen

x View the Monitor IDs

x Map touchscreens

x Reset the touchscreen controller

x Restore the touchscreen factory defaults
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Microcal Basics

Microcal lets you test and adjust the performance of the touchscreen,
and is a useful tool in troubleshooting any problems.

Opening Microcal

To open the Microcal utility, double-click on the Microcal file.

Every time you open Microcal, the system automatically

x Searches for connected touchscreens by scanning the ADB device
table and obtaining the addresses of the touchscreens

x Attempts to communicate with each touchscreen by sending a
request for information to each controller in succession

Menu bar

Icons for accessing
the Microcal options

Touchscreen status
information
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Selecting Microcal Options

You can select a Microcal option in one of three ways:

x Touch or click on an icon in the Microcal window

x Choose a command from the Options menu

 When the Microcal window is active, the Options menu appears in
the menu bar.  Open the Options menu and select the desired
command.

 

Options

Select Touchscreen aS

Draw aD

Calibrate aC

Adjust Frequency aA

Linearize aL

Reset Controller aR

Restore Factory Defaults aF

Map Touchscreens aM

Show Monitor IDs aI

Quit aQ

 Note that the Options menu includes two commands – Reset
Controller and Restore Factory defaults – that are not in the
Microcal window.

x Use the option command key sequence

 Note that the Options menu lists the corresponding key sequence

next to each command.  For example, press aC to calibrate the
touchscreen.  The key sequences are valid anytime the Microcal
window is selected.
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Touchscreen Status Information

The bottom portion of the Microcal window displays status
information for the currently selected touchscreen.

If you are using one touch monitor, that monitor is always the current
touchscreen.

If you are using multiple touch monitors, the last monitor you selected
is the current touchscreen.

Output Identity

The Output Identity specifies the controller type and firmware version
for the currently selected touchscreen.  The format is as follows:

Output Identity - A5 xxxx

where:

A5 = Defines the controller as an ADB/SMT controller.

xxxx = Four ASCII characters that indicate the firmware version
number in decimal format.  The first two characters
represent the version number; the last two characters
represent the revision level.  For example, 0500 means
Version 5, Revision 0 (that is, 5.0).

If you are installing multiple touch monitors, the controller’s output
identity must be A50500 or newer for each touchscreen.  You can
determine the identity of each controller in your system by selecting
each touchscreen and reading its status information.
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Monitor ID

The currently selected touchscreen is identified by the ID number of its
associated monitor.  Refer to “How to Select a Touchscreen” in
Chapter 4 for information on selecting a touchscreen when you have
multiple touch monitors installed.

Status Information Line

The information displayed on this line consists of:

x Progress messages

 For example, when you open Microcal, it searches for connected
touchscreens.  Information about the progress of this search is
displayed.

x Description of each Microcal option

 You can display a brief description of an option by placing the
cursor on the icon and holding the mouse key down.  To avoid
selecting the option, slide the cursor off of the icon before
releasing the button.

x Results of the last operation performed

x Error messages
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Testing the Touchscreen

If you are experiencing problems with the tracking and accuracy of
your cursor, then you need to test your touchscreen.

There are three factors that affect the operation and accuracy of your
touchscreen:

x Calibration

x Operating frequency

x Linearization

Using the Draw option in the following procedures will help you to
determine the best course of action for correcting your touchscreen
problem.

Using the Drawing Option

The Draw option lets you touch the screen and draw lines, shapes, and
curves.  This option is useful for testing the touchscreen’s performance
and cursor movement.

When you choose the Draw option, the system displays a drawing
canvas with a grid.  To draw, touch the screen and drag your finger.
Table 3 lists the keys you can press during a drawing session.

Table 3.  Keys for Microcal Draw

Press … To …

B Clear the screen (including the grid) and then display a
blank screen

G Clear the screen and then display the grid only

H Display the list of keys you can press during the drawing session

Q  or  Esc Exit from the drawing program
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Any time you calibrate the touchscreen, linearize the touchscreen, or
adjust the operating frequency, use the Draw option to test your
changes.

Determining the Probable Cause

¾ To test the current touchscreen:

1. Open Microcal.

2. Select Draw.

3. Press G to clear the screen and display the grid.

4. Move your finger along the edges of the image area from corner to
corner, making the shape of a box.  Do this several times.

5. Look at the box you drew on the screen.

 Your lines should smooth and straight, and be aligned with the
edges of the image area. Verify that the cursor reaches the full
image area of the screen.

 If you cannot move the cursor to all corners and edges of the
screen, then you need to calibrate the touchscreen.  Refer to
“Calibrating the Touchscreen” in Chapter 2.

6. Press G to clear the screen and display the grid.

7. Trace each of the vertical lines displayed on the screen.  Your lines
should follow the grid and be straight and smooth.  Your lines
should be similar in appearance to each other.

The edges of the box are
not aligned with the
edges of the video image.



TouchWare for Macintosh User's Guide50

8. Trace each of the horizontal lines displayed on the screen. Your
lines should follow the grid and be straight and smooth.  Your lines
should be similar in appearance to each other.

9. Look at the lines you drew on the screen.

x If your lines are straight and smooth, but are offset a distance
from the grid lines, then your touchscreen requires calibration.
Refer to “Calibrating the Touchscreen” in Chapter 2.

 

x If your lines are jagged, rough looking, or intermittent, you
need to adjust the touchscreen operating frequency.

 

 Also, if the cursor is jittery, does not move with your finger, or
requires a hard touch to move, you need to adjust the
frequency.

 Refer to “Adjusting the Operating Frequency” later in this
chapter for more information.

The lines have a
ragged appearance.

The lines appear smooth
and straight, but are offset
a distance from the grid
lines.
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x If your lines are curved or distorted, and you are still
experiencing problems with cursor tracking and accuracy, then
you probably need to linearize your touchscreen.  Refer to
“Linearizing the Touchscreen” later in this chapter for more
information.

        

10. Press Q to quit Draw.

When You Should Co ntact Technical Suppo rt

If you have calibrated the touchscreen, adjusted the operating
frequency, and linearized the touchscreen, but are still experiencing
tracking and accuracy problems with your cursor, contact MicroTouch
Technical Support.

Most of the lines appear straight.
However, some portions of the
lines are curved.
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Calibrating the Touchscreen

Calibration is the process of aligning the touchscreen with the
underlying video.  The calibration process determines the dimensions
of the screen, the location of the edges of the screen image, and the
center of the touchscreen.  You should always calibrate at the screen
resolution you will be using.

You should calibrate the touchscreen in the following cases:

x After you have initially installed your touch system

x Any time you change your video card, swap in a new monitor, or
add another touch monitor

x Any time the cursor does not accurately follow the movement of
your finger

x Any time you cannot position the cursor at the edges or corners of
the screen image

x Any time you change the size or position of the video image area
by adjusting the controls on your monitor

x Any time you adjust the touchscreen operating frequency

x Any time you issue a Restore Factory Defaults command

The Calibration option in Microcal is identical to the Calibration
option in the TouchWare control panel.  Refer to “Calibrating the
Touchscreen” in Chapter 2 for a complete description of how to
calibrate your touchscreen.
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Adjusting the Operating Frequency

In general, your touchscreen is immune to any electrical noise that may
be present in the monitor.  However, sometimes this “noise” may be at
the same frequency as the operating frequency of your touchscreen.
This noise could interfere with your system and prevent it from
receiving clear, quality signals when you touch the screen.

The solution to this problem is to change the operating frequency of
your touchscreen.

When You Should Adjust the Frequency

You should adjust the operating frequency if

x The cursor is jittery or erratic when you touch the screen

x Your straight lines drawn in Microcal Draw appear ragged

x The cursor does not track (follow) your finger smoothly as you
drag it across the screen

x You have to press hard on the screen to register a touch

Adjusting the Frequency

To obtain a clear touch signal, use the Adjust Frequency option to
change the operating frequency of the touchscreen.  The range of
adjustment is from 8.333 kHz to 31.250 kHz.  The factory default is
22.727 kHz.

Frequency changes apply to the current touchscreen.  If you have
multiple touch monitors installed be sure to select a touchscreen before
adjusting frequency.  Refer to “How to Select a Touchscreen” in
Chapter 4 for more information.
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¾ To adjust the operating frequency:

1. Open Microcal.

2. Select Adjust Frequency to display the following dialog box:

 

 The Adjust Frequency dialog box displays the frequency the
touchscreen is currently using and the frequency last used.

Note:   Microcal retains only the current frequency when it is
closed.  Each time you open Microcal, the previous frequency box
will contain a string of question marks (?????).

3. Use the scroll bar to select a new frequency. Alternatively, you can
select Default for the default frequency (22.727 kHz).

4. Select Set.  Microcal inputs the new frequency, and then
automatically opens the Draw program so you can test the new
setting.

Testing the New Frequency

When you choose Set, Microcal opens the Draw program.  Test the
new frequency by drawing several horizontal, vertical, and diagonal
lines.  Look for the lines to be smooth and straight.  Touch the screen
and observe the cursor.  It should be steady.
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You can use the following keys when working with the Microcal
drawing program:

x Press F to exit the draw program and return to the Adjust
Frequency dialog box.  This allows you to conveniently set and test
another frequency without exiting the Adjust Frequency option.

x Press G to clear the screen and then display a grid.  This allows
you to erase lines you have drawn.  The grid provides a guide for
drawing straight lines.

x Press B to clear the screen (including the grid) and then display a
blank screen.  This allows you to erase the lines you have drawn.

x Press Q or ESC to exit from the drawing program.

x Press H to display the list of keys you can press.  If the list is
already displayed, pressing H will have no effect.

You should select several operating frequencies.  Test your
touchscreen at each frequency.  If you can obtain good results at more
than one frequency, choose the highest frequency in order to obtain
optimum performance.  In general, a higher frequency produces a
stronger touch signal.

The operating frequency you select is stored in the touchscreen
controller.  The touchscreen will operate at the frequency you set until
you change it again.
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Linearizing the Touchscreen

During the manufacturing process, MicroTouch carefully linearizes
each touchscreen by performing a computer controlled 25-point
analysis.  This linearization analysis insures that every touchscreen
operates with the highest degree of accuracy.

Normally, you should never have to perform the linearization
procedure.  Before attempting to linearize your touchscreen, it is
important that you eliminate other factors, such as calibration and
frequency, that may be affecting the touch accuracy.  To determine if
you need to linearize the touchscreen, follow the procedures described
in “Testing the Touchscreen” earlier in this chapter.

Your touchscreen has been carefully linearized by MicroTouch, and
you should consider the linearization procedure only as a final option.

How to Touch the Screen During Linearization

Linearization requires you to touch targets that are displayed on the
screen.  To obtain the most accurate results:

x Touch each target with the fingertip of an extended finger.

x Keep your palm and free hand away from the touchscreen and
monitor.

x Touch as close to the center of the target as possible.

x Hold your finger as still as possible on the target.  Always lift your
finger straight off the touchscreen.  Do not use any swiping motion
during liftoff.

Linearize Procedure

Linearization applies to the current touchscreen.  If you have multiple
touch monitors installed, be sure to select a touchscreen to linearize.
Refer to “How to Select a Touchscreen” in Chapter 4.

If desired, you can restore the original factory linearization data by
selecting Restore Factory Defaults from the Microcal Options menu.
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Note:   Only the ADB/SMT touchscreen controller supports 25-point
linearization.  Older Macintosh touchscreen controllers do not support
linearization.

¾ To linearize the touchscreen:

1. Open Microcal.

2. Select Linearize.  Microcal displays 25 targets for you to touch in
sequence.  Note that the upper left target has a cross through it.
The cross indicates the target you should touch.

 You can cancel the linearization process at any time by pressing
ESC.  Additionally, if no touch is detected within 25 seconds, the
linearization procedure will automatically terminate.

3. Touch each target, beginning with the target in the upper left
corner.  Be sure to hold your finger on the target for at least four
seconds.  Microcal takes multiple readings for each target.

4. Lift your finger off the first target.  Microcal positions the cross on
the next target you should touch.

Note:   If the cross does not advance to the next target, Microcal
did not receive an accurate reading for the current touch point.
Touch the target again making sure you hold your touch for at
least four seconds.

5. Repeat the process for all 25 targets.

 When you touch the last target, wait for Microcal to complete its
calculations and return to the main menu.  This process will take a
few seconds.
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Resetting the Touchscreen Controller

When you select the Reset Controller command, the system

x Re-initializes the touchscreen controller hardware and firmware

x Momentarily stops the controller from sending data

x Re-calculates the touchscreen operating conditions (for example,
stray and offset capacitance values)

The controller reset is applied to the current touchscreen.  If you have
multiple touch monitors installed be sure to select a touchscreen before
resetting the controller.  Refer to “How to Select a Touchscreen” in
Chapter 4 for more information.

Restoring Touchscreen Factory Default Parameters

The Restore Factory Defaults command in the Microcal Options Menu
causes the touchscreen to revert to the factory default operating
parameters.  This command is useful in situations where inadvertent
commands or actions have rendered the touchscreen inoperative.

The system restores the defaults for the current touchscreen only.  If
you have multiple touch monitors installed, make sure you select a
touchscreen before executing a Restore Factory Defaults command.
For information on selecting and using multiple touch monitors, refer
to Chapter 4.

Touchscreen linearization data, calibration data, and default operating
frequency are restored to their factory default values from data stored
in the touchscreen controller.  You should always calibrate the
touchscreen after you have restored the defaults.

Note:   Even though the operating frequency has been changed to the
default value, the frequency displayed in the Adjust Frequency dialog
box is updated only after Microcal is closed and re-opened.
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Using Monitor IDs

The Macintosh operating system creates an identification number for
each monitor connected to it.  You use these monitor IDs when
mapping and selecting touchscreens.

Displaying All Monitor IDs

Use the Show Monitor IDs option to display the Monitor IDs on the
screen of each monitor in your system.  When you select the Show
Monitor IDs option, Microcal displays an ID number on each monitor
screen for two seconds.  The Show Monitor IDs option is especially
useful if your system has multiple monitors installed.

Viewing the Monitor ID of Current Touchscreen

Located at the bottom of the Microcal screen is the Monitor ID of
Current Touchscreen status.  This status identifies the currently
selected touchscreen for systems configured with multiple
touchscreens.  Microcal options, such as Draw, Calibrate, Adjust
Frequency, Linearize, Restore Factory defaults, and Reset Controller,
only apply to the current touchscreen.

Mapping the Touchscreens

When you have multiple monitors installed, TouchWare needs to know
which monitors have a touchscreen installed.  You use the Map
Touchscreens option to assign each touchscreen to its associated
monitor.  For more information, refer to Chapter 4.
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Selecting a Touchscreen

The Select Touchscreen option allows you to select a specific
touchscreen when you have multiple touch monitors installed.  Refer
to “How to Select a Touchscreen” in Chapter 4.

If you do not have multiple touch monitors installed, this option is not
valid.  There is no need to select a touchscreen if you have only one
installed.

Quitting Microcal

You can exit Microcal by

x Clicking the Stop icon

x Choosing Quit from the Options menu

x Pressing aQ on the keyboard

x Clicking the close box at the top of the Microcal window

Getting Information About Microcal

¾ To display information about Microcal:

1. Select Microcal.

2. Open the Apple menu () and choose About Microcal.

 

Microcal for the Macintosh
Version 3.3
November 10, 1997

¤ 1991-1997 MicroTouch Systems, Inc.
All rights reserved

¾ To close the information window, make another selection.
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Multiple Touch Monitors

In applications where more than one touchscreen is required in a
system, MicroTouch has provided the solution.  TouchWare easily
supports multiple touch monitors.

This chapter describes how to

x Setup multiple touch monitors

x Configure your system for multiple monitors

x Use multiple touch monitors

Note:   TouchWare supports a maximum of two touch monitors
(touchscreens) in a system.
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Multiple Monitor Overview

The following is an overview of the installation and operation of a
system using multiple monitors.

Your system can have a mix of standard and touch monitors.  The
following are some examples of possible system configurations:

x One touch monitor

x One touch monitor plus one or more standard monitors

x Two touch monitors

x Two touch monitors plus one or more standard monitors

Installation and Setup

When you set up a system with multiple touch monitors, you may need
to install additional video ports in your Macintosh.  Each standard
monitor or touch monitor is connected to a separate video port.  Refer
to your Macintosh documentation for information about installing
additional video ports.

After you have installed and connected the hardware, you configure
your Macintosh operating system for multiple monitors.  During this
process you select which monitor will be the main monitor.  The main
monitor is the monitor that displays the menu bar.

Mapping

Each monitor is automatically assigned an identification number by
your Macintosh operating system.  You can use the Show Monitor IDs
option to identify individual monitors in your system.
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Mapping is the process of assigning each touchscreen to its associated
monitor.  Mapping accomplishes two purposes:

x Identifies each touchscreen connected to the ADB and its
associated monitor

x Identifies which monitors are touch monitors and which monitors
are standard monitors

During the mapping procedure, you indicate that a monitor has a
touchscreen installed by touching the ID number displayed on its
screen.  You indicate that a monitor does not have a touchscreen by
pressing the ESC key.

Once mapping has been completed, the Macintosh is able to identify
the type of each monitor by its ID number.

Selecting a Specific Touchscreen

The options in the TouchWare control panel and Microcal are grouped
into two categories.  Options that are applied to all of the touch
monitors in your system simultaneously are called Global Touchscreen
Settings.  Options that are applied to a specific touch monitor in your
system are called Individual Touchscreen Settings.

Before you apply an individual touchscreen setting, you must first
select the specific touchscreen.  The TouchWare control panel and
Microcal have a Select Touchscreen option for this purpose. You
select a touchscreen by touching the monitor ID number displayed.
Only monitors with touchscreens can be selected.
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Setting Up Multiple Touch Monitors

To set up a system with multiple monitors you

x Connect the monitors to the Macintosh

x Install the TouchWare software

x Configure the Macintosh operating system for multiple monitors

x Map the touchscreens

Note:   Only touchscreens using controllers with an Output Identity of
A50500 or newer are supported in multiple touch monitor
configurations.

Connecting the Monitors

Each monitor is connected to a separate video port in the Macintosh.
You may need to install additional video cards.  Additionally, each
touchscreen is also connected to an ADB port.  Refer to “Connecting
a Touch Monitor” in Chapter 1 for information on connecting multiple
touch monitors.

Installing TouchWare

After you have connected the monitors to your Macintosh, you must
install the TouchWare software.

A Display Enabler extension has been included on the TouchWare
diskette.  If you are using System 7.5.2 or earlier, you must install this
extension into the system Extensions folder for your system to work
properly with multiple monitors.

Caution:   If you are using System 7.5.3 or newer, the Display Enabler
extension is already included in the Macintosh operating system.  In
this case, DO NOT install the Display Enabler extension from the
TouchWare diskette.  Erratic system behavior could result.
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Refer to “Installing the Touchscreen Software” in Chapter 1 for the
installation procedure.

Configuring the Macintosh Operating System

When more than one monitor is installed in a system, you must
configure the Macintosh operating system for multiple monitors.  The
Macintosh is then able to identify individual monitors in the system by
creating monitor identification numbers (Monitor IDs).

¾ To configure the Macintosh for multiple monitors:

1. Open the Apple menu () and select Control Panels.

2. Choose Monitors & Sound.  Earlier versions of the Macintosh
referred to the option as Monitors.

3. Select the Arrange icon.

4. Arrange the monitor icons by dragging them on the screen.  You
should position the icons according to how your monitors are
physically arranged.  This could be side by side, or one above the
other.

 You can identify the monitors by clicking and holding the mouse
button on Identify the monitors.  Make sure that the monitor icons
are not on top of one another.

Note:   It is important that the monitors be configured as separate
monitors (non-mirrored) for proper touchscreen mapping.

5. Drag the menu bar onto the monitor icon that represents your main
monitor.  The monitor with the menu bar is the main monitor.  The
TouchWare control panel and Microcal window are displayed on
the main monitor.

6. Click the close box at the top of the window to exit the monitor
setup.
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Mapping the Touchscreens

Mapping is the process of assigning a touchscreen to its associated
monitor by using the monitor ID number.  Once mapping has been
completed, the software can reference any standard or touch monitor
by using the monitor IDs.

Note:   The mapping procedure requires that a keyboard or mouse be
connected to your Macintosh.

Anytime you change the number or type of the monitors in your
system, you must map the touchscreens.  TouchWare always displays
an alert message if the touchscreen mapping is not correct.

¾ To map the touchscreens:

1. Open the Apple menu () and select Control Panels.

2. Select TouchWare.  If this is the first time you opened the
TouchWare control panel or Microcal with multiple touchscreens
installed, or you changed the number or type of monitors in your
system, TouchWare displays the following alert message:
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3. Click OK.  The system displays instructions on how to map your
touchscreens.

 

 You can select Cancel to exit the mapping procedure.  However, if
you have modified the monitor configuration of your system, you
must map your touchscreens.  Failure to do so will result in erratic
operation of your touchscreens.

4. Click Begin.  The system displays an ID number on each monitor
in succession.

x If the monitor displaying the ID number has a touchscreen,
touch the ID number.

 If the system recognizes your touch, the following message
box appears:
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x If the monitor does not have a touchscreen, press the ESC key.

 If your touch did not register or you pressed the ESC key, the
following message box appears:

 

 If this monitor has a touchscreen, but your touch was not
detected, complete the mapping procedure before attempting
to troubleshoot the problem.

5. Click OK to continue mapping the remaining monitors in your
system.

When you have completed mapping all the monitors, the system
displays the results:

If an error was encountered during mapping the system displays an
alert message.  Restart your Macintosh and repeat the mapping
procedure.  If the problem(s) persist, refer to Chapter 5 for
troubleshooting tips.



Chapter 4  Multiple Touch Monitors 69

Using Multiple Touch Monitors

When multiple touch monitors are installed, the touchscreen options in
the TouchWare control panel and Microcal are directed to either all
touchscreens simultaneously, or to a specific touchscreen.  Otherwise,
the functionality of each option is the same regardless of the number of
touchscreens configured in your system.

The options are grouped into two categories:

x Global touchscreen settings

x Individual touchscreen settings

Global Touchscreen Settings

Global options are directed to all touchscreens at the same time.  For
example, when you select the Touch Mode option in the control panel,
all touchscreens are set simultaneously to the same mode.

Individual Touchscreen Settings

Individual options are directed to the currently selected touchscreen
only.  For example, when you choose Calibrate in the control panel,
only the current touchscreen is calibrated.

You use the Select Touchscreen option to make a touchscreen the
current touchscreen.  This option is available in both the TouchWare
control panel and Microcal.

If you are calibrating multiple touchscreens for example, you must
select and calibrate each touchscreen.

How to Select a Touchscreen

To select a touchscreen to be the current touchscreen, use the Select
Touchscreen option.  The system displays a monitor ID on each
screen.  To select a touchscreen, touch the ID number displayed on the
desired monitor.  This touchscreen becomes the currently selected
touchscreen.
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You can identify the current touchscreen by its monitor ID number.
The TouchWare control panel and Microcal display the ID number of
the currently selected touchscreen at the bottom of the window.

Note:   Although the cursor automatically follows your touch from
touch monitor to touch monitor, only one touchscreen is the currently
selected touchscreen.  An individual setting is applied to the current
touchscreen only.

¾ To select a touchscreen:

1. Open the TouchWare control panel or Microcal.  The Select
Touchscreen option in each is identical.

2. Choose Select Touchscreen.  The following message box appears:

 

3. Click Begin.  Identification numbers appear on all monitors.

4. Touch the ID number on the touchscreen you want to select as the
current touchscreen.
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5. Click OK.  The selection process is completed.  Notice that the
Current Monitor ID status has been updated.

Note:   It is possible for the TouchWare control panel and Microcal to
have different touchscreens selected.  Always check the Current
Monitor ID number before choosing an option.

TouchWare Control Panel

When you use multiple touch monitors, the TouchWare control panel
has a Select Touchscreen option available.  This option lets you select
a specific touchscreen to be the current touchscreen.  The individual
settings are only applied to the current touchscreen.

A global setting is
applied to all
touchscreens
simultaneously.

An individual setting
is applied to the
current touchscreen
only.

Use this option to
select a touchscreen
to be the current
touchscreen.
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Microcal

All Microcal options are applied to the current touchscreen only.  Use
the Select Touchscreen option to specify a touchscreen to be the
current touchscreen.

Use this option to
select a touchscreen

to be the current
touchscreen

Identifies the current
touchscreen
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Troubleshooting

This chapter provides tips and strategies for solving problems you may
encounter with the touchscreen either during installation or normal
use.

MicroTouch is committed to helping you get the most from your
touchscreen.  MicroTouch provides extensive technical support
through our phone Help Desk, Internet, and online Bulletin Board.
For more information on technical support, refer to the “About This
Manual” section at the beginning of this document.
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Troubleshooting Common Problems

This section lists common problems experienced by users working
with the touchscreen.

Problem: Cannot activate items by tapping the touchscreen.
The tap speed and tap area define the conditions that must exist for the
system to interpret your touches as a double-click or drag.  Use the
TouchWare control panel to adjust the tap speed and tap area.  If you
tap slowly, be sure to set the speed to slow in order for the second tap
to register with the system.  For more information on making these
adjustments, refer to Chapter 2.

Problem: Requires pressing hard on the touchscreen to register a touch or to
drag the cursor.
When operating normally, the touchscreen requires a light touch to
respond.  If you find that a firm or hard touch is required, the current
operating frequency is probably being interfered with.

To correct this problem, run Microcal and select the Adjust Frequency
option.  Change the operating frequency of the touchscreen as many
times as necessary until you find a frequency that allows a light touch
to be recognized (see “Problem: Cursor is jittery”).

For more information on making these adjustments, refer to Chapter 3.

Problem: Cannot move the cursor to the edges of the screen.
The touchscreen is not properly aligned with the underlying video.
You need to re-calibrate the touchscreen.  For more information on
how to calibrate the touchscreen, refer to Chapter 2.

When calibrating the screen, be sure you touch the center of each
target firmly and precisely.  Use the Microcal Draw program to check
for proper touchscreen operation.

Note:   You can touch the screen and then drag your finger to the
center of the target.  The system does not register the touch point until
you lift your finger off the screen.  Once you position your finger, be
sure to hold the touch for at least three seconds.



Chapter 5  Troubleshooting 75

Problem: Cursor is jumpy or takes sudden bounces across the screen.
The touchscreen is receiving more than one touch at the same time.
When you touch the screen, be sure to point and touch with one finger
only.  Keep your other fingers away from the touchscreen.

If more than one finger touches the screen, the cursor jumps from one
location to the next.  In the case of two fingers touching, the cursor
moves to a spot halfway between the two touch points.  Touch only
one location at a time.

Problem: Cursor is jittery .
The touchscreen is receiving too much interference from the monitor.
You need to adjust the operating frequency of the touchscreen.

Run Microcal and use the Adjust Frequency option to change the
frequency.  Test touchscreen operation after each frequency change
with the Draw program.  Generally, use the highest setting that
produces the smoothest lines and provides best overall operation.

Problem: Lines are not straight and smooth .
Could be one of the following problems:

x You need to adjust the operating frequency of the touchscreen.
Run Microcal and use the Adjust Frequency option to change the
frequency.  Select a new frequency and test it with the Draw
program.  Generally, use the highest setting that produces the
smoothest lines and provides best overall operation.

x The touchscreen is not linear.  Run Microcal and use the Linearize
option to perform a 25-point linearization.

Problem: The Linearize option in Microcal does not work .
Only the ADB/SMT touchscreen controller supports 25-point
linearization.  Older Macintosh touchscreen controllers do not support
linearization.
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Problem: TouchWare icon does not appear when the Macintosh is started.
There is probably more than one System Folder on the hard disk.
Open the File menu and choose the Find command to search for
System.  Locate the active folder.  Make sure the TouchWare icon is in
the active System Folder.

Problem: Multiple TouchWare icons appear at start up.
There is more than one TouchWare driver in the System Folder.
When you start your Macintosh, the system loads both drivers and
displays two TouchWare icons at startup.

Note:   If you upgraded from a previous version of the Mac ’n Touch
software, you must remove any old Mac ’n Touch control panels from
the System Folder.  In Version 3.0, the control panel name changed
from Mac ’n Touch to TouchWare.  Therefore, the old control panel
will not be overwritten when you install the new TouchWare control
panel.  Leaving the old Mac ’n Touch control panel installed will cause
problems and conflicts, including a system crash when you open either
control panel.

To correct this problem, open the System Folder and look for
duplicates of the TouchWare software driver.  Only the most current
version of the TouchWare software should be installed.  You must
remove all extra versions from the Control Panels folder.

To determine the latest version of the driver, highlight (select) each file
in turn, open the File menu, and choose Get Info.  The information
window lists the creation date and version number for the currently
highlighted file.
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Troubleshooting Multiple Touchscreens

Problem: Touch one screen, but the cursor appears on another screen .
Your touchscreen controller does not support multiple touchscreens.
Only the ADB/SMT touchscreen controller with an Output Identity of
A50500 or newer support multiple touchscreens.

If your controllers have an Output Identity of A50500 or newer, then
there is a device conflict on the ADB bus.  Shut down your Macintosh
and the restart you system to clear any bus contentions.

Problem: After a Reset, Frequency Adjust, or Restore Factory Defaults has been
executed, the touchscreens behave erratically .
The touchscreen controllers do not support multiple touchscreens.
Only the ADB/SMT touchscreen controller with Output Identity
A50500 or newer support multiple touchscreens.

Problem: When configuring multiple monitors, the Arrange icon is missing .
Your system is configured with a single video port.  Additional ports
are required for multiple monitor configurations.  Refer to your
Macintosh documentation.

Problem: The TouchWare control panel appears on all my monitors.
Your system is configured for duplicate or mirrored monitors.  Re-
configure your Macintosh and remove duplication by dragging the
screen icons apart.  Refer to “Configuring the Macintosh Operating
System” in Chapter 4.

Problem: When mapping touchscreens, the system does not detect all
touchscreens .
Check that all your touchscreen cables are connected to the ADB bus.
Verify that each controller is detecting touch by checking its LED.

Problem: Touch not recognized when mapping or selecting touchscreens .
The touchscreen is receiving too much interference.  Use Microcal to
adjust the touchscreen operating frequency.
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Error Messages

This section lists the error messages that you may receive when
installing the touchscreen software, using the TouchWare control
panel, or running the Microcal Diagnostic utility.

Error: Output status reported one or more of the following errors: RAM,
ROM, A/D, NOVRAM, and ASIC.
This error indicates there is a problem with the hardware.  Contact
MicroTouch Technical Support for help.

Error: The control panel “TouchWare” cannot be used with this Macintosh .
The Macintosh cannot open the control panel because it does not
recognize or cannot find the touchscreen.

Several problems can produce this error message:

x You installed the TouchWare software but did not restart the
Macintosh.  You need to restart the Macintosh so the system
recognizes the new driver software.

x The touchscreen cable is not connected to an ADB port and the
ADB manager cannot talk to it, or the touchscreen conflicts with
another device in the daisy chain.

To correct this problem, shut down your Macintosh.  Make sure the
touchscreen cable is properly connected.  Start the Macintosh and
make sure the TouchWare icon appears on the screen during the start
up process.

If your Macintosh has only one ADB port, use the ADB-Splitter cable
to connect the touchscreen with other input devices, such as a tablet or
mouse.

Error: Touchscreen is not responding .  Check connections.
The touchscreen cable is not properly connected to an ADB port.
Check the cable connection, restart the Macintosh, and try again.
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Error: Touchscreen not found on the ADB device table .  Send the
“ADBReInit” command to the ADB manager?
Microcal could not obtain the touchscreen address from the ADB
device table.  This error can occur if you did not restart the Macintosh
after installing the touchscreen hardware and software.  The bus does
not recognize the touchscreen as a valid device.

Choose Yes to reset the Apple Desktop Bus.  During the reset, the
ADB manager polls each device attached to the system and stores the
information in the ADB device table.  If the error message reappears,
check all cable connections, restart the Macintosh, and try again.

Error: No touchscreen mapped.  Monitor x does not have a touchscreen or
the touchscreen is not responding .

TouchWare has detected a monitor that is not identified as a
touchscreen.

This error can occur if

x The touchscreen cable is not connected to the ADB port or is not
connected properly.

x The touchscreen controller is faulty.

x You pressed ESC during touchscreen mapping to indicate that this
monitor did not have a touchscreen attached.

Error: TouchWare (Microcal) has encountered an error mapping the
touchscreens.

TouchWare has detected a monitor that is not identified as a
touchscreen.

This error can occur if

x The touchscreen cable is not connected to the ADB port or is not
connected properly.

x The touchscreen controller is faulty.

x You pressed ESC during touchscreen mapping to indicate that this
monitor did not have a touchscreen attached.



TouchWare for Macintosh User's Guide80

Status Light on the Controller

The touchscreen controller has a light-emitting diode (LED) built into
it. The LED provides valuable information about the status of the
touchscreen and controller.

If you are experiencing problems with the touchscreen, be sure to
check the LED.  Refer to Table 4 for an explanation of a bright, dim,
and blinking LED.

Table 4.  LED Status Information

Status of LED Meaning

Bright Indicates one of the following conditions:

x Power has been applied to the controller, but
communication with the controller has not been
started.

x Controller has been initialized.

x The sensor is being touched.

Continuously Dim Indicates the sensor is not being touched.

Blinking Indicates the power-on self-test failed.  Possible
errors are as follows:

1 flash per 10 seconds
2 flashes per 10 seconds
3 flashes per 10 seconds
4 flashes per 10 seconds
5 flashes per 10 seconds

=
=
=
=
=

RAM error
ROM error
A/D error
NOVRAM error
Analog error



Chapter 5  Troubleshooting 81

Touchscreen Care and Cleaning

Touchscreen maintenance is minimal.

MicroTouch does, however, recommend that you periodically clean the
glass touchscreen surface.

x Use isopropyl alcohol, or a non-abrasive glass cleaner.  Avoid
using cleaners other than glass cleaners.  Do not use any
vinegar-based solutions.

x Apply the cleaner with a soft cloth.  Avoid using gritty cloths.

x Always dampen the cloth and then clean the screen.

Always handle the touchscreen with care.  Do not pull on or stress
cables.
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